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This patch integrates LoadRunner's TruClient - Native Mobile protocol with HP Mobile Center, enabling you to test
mobile applications on real devices. For full details, check out the HP Mobile Center Help.

This patch also provides the contents of Patch 1, which was an update for TruClient-Firefox users, providing
support for Firefox version 30. When planning your test, note that due to Firefox's internal design, Firefox version
30 consumes an average of 20 MB more memory than version 22. 

Patch 3 can be installed over LoadRunner version 12.01, and over the previous patches, Patch 1 and Patch 2.

A later edition of the Readme file may be available. For updates, check one of these locations: HP Live Network
(HPLN) or the HP Software Manuals Web site.

This file provides information about LoadRunner 12.01, such as new features, system requirements, and known
issues.

What's New in LoadRunner 12.00 and 12.01

Installation and Configuration Information

Notes and Limitations

Support Information

Legal Notices

What's New in LoadRunner 12.00 and 12.01
The following section lists the primary enhancements and new features for LoadRunner 12.00 and 12.01.

For more information on the new features, refer to the What’s New section within the LoadRunner product, which
includes links to the relevant sections. The What’s New section is accessible from the Help menu or from the
Help’s Contents list.

Support for load generators on the cloud

Easily provision cloud load generators from the Controller

Ability to run tests on load generators on Amazon EC2 Cloud

Ability to run tests on load generators on HP Cloud Compute (added in 12.01)

Enhanced communication interface between Controller and load generators

Ability to configure the ports between all LoadRunner components including the Controller, load generator, MI
Listener, and Monitor over Firewall

Ability to connect from Controller to load generator, MI Listener, and Monitor over Firewall via proxy

Use of Network Connection profiles that let you configure connection information, such as port and proxy,
separately for each load generator

http://mobilecenterhelp.saas.hp.com/
https://hpln.hp.com/page/hp-loadrunner-1201-readme
https://hpln.hp.com/page/hp-loadrunner-1201-readme
https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=


Ability to configure load generator to accept communication only from trusted Controllers using SSL
authentication

Improved support and enhanced usability for SSL security, including the latest version of OpenSSL, 1.0.1h,
solving all known security issues, such as Heartbleed and SSL/TLS MITM. (added in 12.01)

Network and security manager

New utility to configure network and security settings for LoadRunner agent, for both local and remote machines

Enhancements for testing mobile applications

Replay support for SMP (SAP Mobile Platform) recorded sessions

Enhanced proxy recording

Improvements and added features in VuGen

Enhanced replay summary with transaction breakdown including new time- trend charts

Support for editing common file types in VuGen editor, and not limited to Vuser scripts

Ability to cancel a recording session without overwriting the script

Improved stability and performance for Web correlations

Improved search capabilities

Debugger improvements

Ability to disable snapshot creation during replay (added in 12.01)

Ability to add extra files to parser list and extract steps from extra files (added in 12.01)

Ability to configure Enhanced XML view (added in 12.01)

Ability to create a Web correlation from the Replay snapshot (added in 12.01)

Enhancements and added integrations for protocols

Web HTTP/HTML:

HTML5 WebSocket support

TruClient to Web HTTP/HTML protocol script converter

SSL utility for performing various OpenSSL commands through a user-friendly interface

SPDY support

Internet Explorer 11 support

TLS 1.1, TLS 1.2, and TLS NPN support

Enhanced asynchronous support with ResponseHeader callback

Usability and troubleshooting enhancements such as ability to identify recording failure and suggest a possible
fix

Correlation improvements

Linux support: Replay now supports additional protocols on Linux-based load generators: ODBC (added in
12.01), FTP, IMAP, LDAP, POP3, SMTP, and Windows Sockets

TruClient: Support for rendezvous points, IP Spoofing, HP Network Virtualization, and modem speed

https://www.openssl.org/news/secadv_20140407.txt
https://www.openssl.org/news/secadv_20140605.txt


emulation

Silverlight: Support for latest version and IP Spoofing

SAP-Web: Design Studio support in VuGen

LDAP: Support for latest version of LDAP SDK

Flex: Support for the latest Flex SDK

Java over HTTP: Support for mixed, chunked, and gzipped data in HTTP server responses

.NET: Support for version 4.5

Citrix: Support for the latest versions of client receiver and XenDesktop, and the ability to run multiple
published applications in the same session

SAP: SAP Application Testing by HP, HANA Edition (LoadRunner and Quality Center/Application Lifecycle
Management) has received a Premium Qualification for SAP Vendor Branded Resellers. This certification is
effective from LoadRunner 11.50 and Application Lifecycle Management 11.00.

Analysis Improvements

New graphs for WebSocket messages and connections (added in 12.01)

Reduction in HTML report generation time (added in 12.01)

New supported technologies and platforms

Windows Server 2012 R2 and Windows 8.1 support (added in 12.01)

Record support for Web-based protocols with Internet Explorer 11, Chrome version 35, and Firefox version
30(added in Patch 1)

Support for latest versions of Eclipse, JUnit, NUnit, Jenkins, and Selenium (updated in 12.01)

Revised Linux load generator support matrix and support for SUSE (added in 12.01)

External IDE integration/add-ins for LoadRunner scripts and applications

Ability to invoke the Controller directly from Visual Studio and Eclipse

Add-in for Visual Studio 2012 for VuGen scripts and unit test developers

Support for latest version of Eclipse

Improvements in Virtual Table Server (VTS)

Create multiple running instances of VTS

Run VTS commands and batch files from the command line

VTS support through a JavaScript API

Populate data tables with sample data from the main menu

Ability to monitor VTS changes from administrator user interface (added in 12.01)

For details, see the Virtual Table Server (VTS) User Guide. This is available with the VTS installation under the
DVD's Additional Components folder.

Integration with latest HP product versions

For details , see the support matrix at http://support.openview.hp.com/selfsolve/document/KM00963216.

http://support.openview.hp.com/selfsolve/document/KM00963216


HP Service Virtualization

HP Diagnostics

HP SiteScope

HP Unified Functional Testing (UFT)

HP Application Lifecycle Management (ALM)

HP Network Virtualization

Improved documentation

Workflow diagrams added to user guide for testing and script creation processes

Enhancements to Flex, Web HTTP/HTML, and TruClient protocol documentation, with added tasks and
procedures

Improved organization of function reference including additional code samples and the new WebSocket functions

General enhancements

Simplified product installation with shorter installation time

Enhancements in the Linux load generator installation (added in 12.01)

Usability Improvements when working with multiple applications (added in 12.01)

Non-admin user support: LoadRunner components can now run under a standard user account and with UAC
and DEP enabled—an administrator account is no longer required. This applies to all LoadRunner components
and tools.
Note: If you open a service call to HP Support, you may be instructed to log in as an administrator for the
purpose of troubleshooting.

HP Network Virtualization integration enhancements

Database API functions are now available for all C language protocols

Enhanced Citrix section, providing updated and streamlined documentation on setting up your Citrix environment
and testing Citrix applications. (added in 12.01)

Community license bundle

LoadRunner is now delivered with the Community Bundle which replaces the Instant-on license with the
following features:

A permanent bundle with 50 Vusers

All protocols are included except for GUI (UFT), COM/DCOM and protocols in the template bundle

Mobile license bundle

A custom license bundle for testing mobile applications, including the Mobile Application - HTTP/HTML,
TruClient Ajax - Mobile, and SMP protocols (added in 12.01)

 Installation and Configuration Information
For a complete list of supported integrations, product versions, system requirements, and compatibility, see the
Support Matrices site or the Product Compatibility Matrix for LoadRunner 12.01. To locate this document, go to the
Software Support site at www.hp.com/go/hpsoftwaresupport , click the Self-solve tab, and open the LoadRunner
12.01 manuals.

Permission requirements

http://support.openview.hp.com/sc/support_matrices.jsp#LR
http://www.hp.com/go/hpsoftwaresupport


The Installation process, for all components, requires a full administrator account (root account for Linux systems)
for all operating systems.

After installation, all of the LoadRunner applications and components run under a standard user account (an
administrator account is not required), with UAC and DEP enabled. For limitations relating to user permissions for
specific features and components, see Permissions .

Note: On Windows 8.1, a restart is required after installing the prerequisite Microsoft Visual C++ 2005
Redistributable Packages. Restart the machine and run setup.exe again from the DVD or from the
downloaded package.

Language Packs

To install a language pack, at the completion of the LoadRunner installation, run the language pack setup from the
LoadRunner DVD lrunner/<language_name> folder.

System Requirements for full version of LoadRunner, VuGen, and Analysis

The following table describes the system requirements for installing the full version of LoadRunner, VuGen
standalone, or Analysis standalone. Memory and CPU requirements vary per protocol and system under test.

Note: Windows 8.1 and Windows 2012 R2 can only be used in conjunction with Internet Explorer 11—earlier
versions cannot be installed.

Requirement Value

Processor speed 1.6 GHZ or faster

Operating system
Windows Server 2008 R2 SP1 64-bit

Windows Server 2012 R2 64-bit

Windows 7 SP1 32 (supported) or 64-bit (recommended)

Windows 8.1 64-bit

Memory (RAM) Minimum: 2 GB
Recommended: 4 GB or higher

Screen resolution Minimum: 1024 x 768

Browser Microsoft Internet Explorer 8, 9 , 10, or 11

Available hard disk space Minimum: 40 GB

System Requirements for load generators and MI Listener on Windows machines

The following table describes the system requirements for installing a load generator or MI Listener on a Windows
machine. Memory and CPU requirements vary per protocol and system under test.

Note: Windows 8.1 and Windows 2012 R2 can only be used in conjunction with Internet Explorer 11—earlier
versions cannot be installed.

Requirement Value

Processor speed 1.6 GHZ or faster

Operating system



Windows Server 2008 R2 SP1 64-bit

Windows Server 2012 R2 64-bit

Windows 7 SP1 32 (supported) or 64-bit (recommended)

Windows 8.1 64-bit

Memory (RAM) Minimum: 1 GB for Load Generator or 2GB for MI Listener
Recommended: 4 GB or higher

Screen resolution Minimum: 1024 x 768

Browser Microsoft Internet Explorer 8, 9, 10, or 11

Available hard disk space Minimum: 40 GB

System Requirements for load generators on Linux Machines

The following table lists the system requirements for installing a load generator on a Linux machine. Memory and
CPU requirements vary per protocol and system under test.

Requirement Value

Processor speed 1.6 GHZ or faster

Memory (RAM) Minimum: 1 GB
Recommended: 4GB or higher

Available hard disk space Minimum: 500 MB

Supported Linux distributions

The following table lists the Linux distributions on which you can install a load generator on a Linux machine.

Distribution Version

Red Hat Enterprise Linux
Red Hat Enterprise Linux 32-bit 5.8, 6.4

Red Hat Enterprise Linux 64-bit 5.8, 6.4

Oracle Enterprise Linux
Oracle Enterprise Linux 64-bit 5.8 UEK, 6.0 UEK

Ubuntu Server
Ubuntu Server Linux 64-bit 10.04 LTS, 12.04 LTS

Suse SLES (Linux Server
Enterprise) 64-bit version 11

Note: Load generators support all X Servers.

Prerequisite packages for 64-bit installations



The following table lists the packages that must be installed on Linux machines before installing the 64-bit version
of a load generator.

Distribution Prerequisites How to check if it is
installed

How to install

Red Hat family
including Oracle
Linux

glibc.i686
rpm -qa --qf
'%{NAME}.%{ARCH}\n' |
grep -E 'glibc\.(i686|i386)'

yum install
<package_name>

libstdc++.i686(Oralce Linux 6)

libstdc++.i686 (Redhat Linux 5, Oralce
Linux 5)

libstdc++47.i686 (Amazon Linux)

rpm -qa --qf
'%{NAME}.%{ARCH}\n' |
grep -E 'libstdc\+\+[0-
9]*\.(i686|i386)'

ncurses-libs.i686 (needed by
SecurityConsole)

ncurses.i386 (Redhat Linux 5)

rpm -qa --qf
'%{NAME}.%{ARCH}\n' |
grep -E 'ncurses(-libs)?
\.(i686|i386)'

Ubuntu Server
libc6-i386

lib32stdc++6

dpkg -l libc6-i386

dpkg -l lib32stdc++6

apt-get install
<package_name>

lib32ncurses5 (needed by
SecurityConsole)

 

SUSE Linux
Enterprise Server
(SLES) 64-bit

lincurses5 32-bit

glibc 32bit

libstdc++6 32-bit

rpm -qa --qf
'%{NAME}.%{ARCH}\n'
| grep -E 'ncurses[0-
9]*-32bit'

rpm -qa --qf
'%{NAME}.%{ARCH}\n'
| grep -E 'glibc-32bit'

rpm -qa --qf
'%{NAME}.%{ARCH}\n'
| grep -E 'libstdc\+\+6-
32bit'

zypper install
libncurses5-32-
bit

zypper install
glibc-32-bit

zypper install
libstdc++6-32-
bit

Note: The prerequisites listed in the table above indicate the naming patterns for the required packages.
Actual names may vary depending on the exact system architecture.

LoadRunner Component Coexistence Matrix

The following table describes which LoadRunner products can coexist on the same machine:

First
Installation /
Second

LoadRunner
Full

VuGen
Standalone

Analysis
Standalone

Load
Generator

Monitor
Over

Firewall

MI
Listener

Performance
Validation

SDK



Installation

LR Full -- No No No No No No

VuGen
Standalone

No -- Yes No No No No

Analysis
Standalone

No Yes -- No No No No

Load
Generator

No No No -- No No No

Monitor over
Firewall

No No No No -- No No

MI Listener No No No No No -- No

Performance
Validation
SDK

Yes No No No No No --

Additional Installations and Upgrades

All of the standalone installations (such as Load Generator and so forth) can be found on the DVD's
Standalone Applications folder.

All of the additional components (such as the Citrix Agent and so forth) can be found on the DVD's Additional
Components folder.

You can install LoadRunner 12.01 over an existing, earlier version of LoadRunner. If, however, you have a pre-
11.00 version of LoadRunner, you must uninstall it before installing LoadRunner 12.01.

Note: To replay ODBC Protocol scripts on Linux machines, unixODBC v.2.3.1 or higher is required.

Virtual Table Server (VTS)

If you have an older version of VTS, uninstall it and reinstall the latest version from the Additional Components
folder on the DVD.

 Notes and Limitations
This section includes pre-installation notes, issues, and workarounds for LoadRunner version 12.01.

For additional limitations and workarounds, see the "Troubleshooting and Limitations" sections in the LoadRunner
User Guide.

Installation

Permissions

VuGen

Controller and General

Integrations

Protocol SDK

 Installation

Windows



When you have multiple LoadRunner components installed on a machine for example, both VuGen and Analysis
(standalone versions) and you uninstall one of the components—after the uninstall, you must run Repair on the
remaining components.

If you are running McAfee or Aladdin's eSafe anti-virus applications, close them before installing LoadRunner.

If you are running McAfee's anti-virus applications, note that it blocks port 443 used as the default by the
LoadRunner agent. You need to manually enable this port. To disable the port, open the McAfee configuration
dialog box. In the Firewall Policy tab, add a new rule to allow Port 443 - Action: Permit IP: TCP, Incoming
traffic for the HP LoadRunner Agent Process.

The installation wizards for the VuGen and Analysis standalone products are not localized—they are only
available in English.

If you install a language pack after you have already generated an Analysis session, you will not be able to open
the session file (.lra). You can only open it on a machine with the same regional settings as the machine upon
which it was generated. You can, however, open the raw results, the .lrr file.

Linux

When uninstalling a load generator on a Linux machine, the uninstall process may fail and the following message
may appear: "Error: failed & because &: cannot restore segment port after reloc: permission denied"
Workaround: Use the setenforce 0 command to disable SE Linux before uninstalling the load generator.
When the uninstall is complete, use the setenforce 1 command to enable SE Linux.
Note: This limitation applies only to Oracle 5.0 and Red Hat 5 [32-bit].

Coexistence with Unified Functional Testing (UFT)

If you install LoadRunner and UFT on the same machine. and then uninstall one of them, the remaining software
program may not function correctly. 
Workaround: Reinstall the software program you want to use on the machine.

A machine with LoadRunner and UFT, in which UFT was installed after LoadRunner, may not allow the
recording of certain protocols. 
Workaround: Uninstall UFT and run a Repair on the LoadRunner installation.

If you install UFT on a load generator machine when the load generator agent is running, the remote Controller
may not be able to run UFT scripts on the load generator machine.
Workaround: After installing UFT, restart the load generator agent using the Agent Configuration utility, or
alternatively reboot the machine.

 Permissions

Issue: When running the LoadRunner License utility with UAC enabled, LoadRunner prompts you for
administrator credentials.
Resolution: Run the utility as administrator.

Issue: When recording and replaying TruClient - IE scripts ( and recording Web protocol scripts) on a Window
Server operating system, it is recommended to turn off Internet Explorer Enhanced Security Configuration (IE
ESC). 
Resolution: 
In Windows 2012 R2: Server Manager > Local Server > Internet Explorer Enhanced Security Configuration.
In Windows 2008 R2: Server Manager > Security Information > Configure IE ESC.

Issue: When using the Visual Studio 2010 and 2012 add-ins to create C# and VB .NET scripts: Visual Studio
creates .NET assemblies that need to be registered in the system before their run. Registration of the .NET
assembly requires administrative permissions.
Resolution: Enable UAC and register the .NET assembly before running the test using one of these methods:

Run Visual Studio "As Administrator" and provide administrative credentials when prompted. In Project
Settings, ensure that the Register for COM interop option is set (Project > Properties > Build >
Register for COM interop). Visual Studio will automatically register the test DLL as a .NET assembly
every time it builds the project.



Run Visual Studio without administrative permissions, and manually register the test DLL after it is built. To do
so, run Windows Console with administrative permissions and run the following command:
%WINDIR%\Microsoft.NET\Framework\v4.0.30319\RegAsm.exe <TargetDLLwithPath> /codebase (ignore the
warning issued when you run this command). 
For example, you might replace <TargetDLLwithPath> with "c:\users\qatest\documents\visual studio
2010\Projects\LoadRunnerUser1\LoadRunnerUser1\LoadRunnerUser1.dll." You do not need to register the
DLL after every build. It is enough to register it once after making changes in the COM interfaces defined in
the DLL.

Issue: The IP Wizard does not function for a Limited user.
Resolution: Run the IP Wizard with administrator permissions. The IP Wizard uses raw sockets to
communicate with remote machines. Therefore, administrative privileges are required for opening and using raw
sockets in socket-based communication. For more information, see http://msdn.microsoft.com/en-
us/library/windows/desktop/ms740548%28v=vs.85%29.aspx. Alternatively, you can set the IP Wizard settings
locally on the target machine.

Issue: When recording a Web-based protocol script, the recording may fail in certain installations, if Data
Execution Prevention (DEP) is enabled. 
Resolution: Disable DEP on your machine. For details, see How to Record a Vuser Script in the User
Guide.

Issue: Unable to set agent Run-time settings (Start Menu >... > HP LoadRunner > Tools > Agent
Runtime Setting Configuration or in icon-based desktops such as Windows 8, search for Agent and
select the Agent Runtime Setting Configuration item) as a Limited user. 
Resolution: Run the tool with administrator permissions. The tool requires these permissions since it installs or
removes the LoadRunner Agent Windows service.

Issue: The network settings for load generators on Linux machines cannot be configured by a Limited user. 
Resolution: When working on a Linux operating system, run lr_agent_settings with administrator
permissions.

 VuGen

Replay fails for a script recorded on the HP WebTours application. 
Workaround: Set the run-time settings to work with no proxy.

Insert Text Check functionality is not supported for 64-bit browsers.
Workaround: Add a Text Check from the Snapshot pane after the script is generated.

PowerTerm is not supported on Windows 8 or Windows 2012 server machines. Running RTE scripts from the
Controller is not supported for these operating systems.

If you open an HP site in the embedded browser and the site is not included in the trusted sites list, you will be
prompted to add the site to the trusted site list. After adding the site, you may receive a Web site scripting error.
Close the error and continue working as you normally would.

For the following protocols, replay is supported, but recording is no longer supported: Siebel - DB2 CLI, i-mode,
EJB, Sybase Dblib, Sybase Ctlib, Informix, PeopleSoft-Tuxedo, PeopleSoft Enterprise, Tuxedo, VBScript Vuser,
JavaScript Vuser, SQL Server, and Web Click and Script. These protocols will be removed from future releases
of LoadRunner.

Run-time errors generated during the replay of VBScript scripts, may not be handled properly. It is
recommended that you port existing VBScript scripts to C. 
Possible Workaround: Enable the Continue on Error option in the Run-time setting.

The VB protocol has been deprecated beginning LoadRunner 11.50.

When adding a conditional breakpoint based on a parameter value, the value is not updated immediately.
Therefore, in the script step that follows, the condition may be ignored even though the argument value has been
updated.

Media Player - MMS: If you specify a non-default bandwidth in the run-time settings, LoadRunner may issue an
error during replay.

http://msdn.microsoft.com/en-us/library/windows/desktop/ms740548(v=vs.85).aspx
http://msdn.microsoft.com/en-us/library/windows/desktop/ms740548(v=vs.85).aspx


TruClient:

The following features are not supported for Internet Explorer version 11: HP Network Virtualization, modem
speed emulation.

Connection reporting is not supported when working with Internet Explorer version 11.

If you added custom configurations to the pref.js or user.js files for scripts recorded with LoadRunner 11.52,
you will need to re-add them to the LoadRunner 12.xx script files. 
Tip: it is recommended that you backup existing files before you begin editing scripts with custom
configurations in LoadRunner 12.xx.

 Controller and General

On Windows 8 and higher, Disabling UAC,may block Acrobat Reader from opening PDF files. Follow the
Windows Help instructions to enable UAC and trusting Acrobat.

In the Test Results Viewer, certain menu commands are not available, such as Print and Copy. You may also be
unable to print or export to HTML certain test results.

For LoadRunner installed on a Windows Server operating system, Internet Explorer Enhanced Security
Configuration must be disabled in order to view help content. It is enabled by default (Control Panel >
Administrative tools > Server manager > Configure IE ESC). For details on disabling enhanced
security, see VuGen - Troubleshooting and Limitations in the User Guide.

HP Network Virtualization (Shunra) is not supported for C# .NET, C++ .NET, or VB .NET scripts created using
the Visual Studio add-in for LoadRunner, nor is it compatible with Internet Explorer 11.

The following monitors have been deprecated for this version of LoadRunner: CheckPoint FireWall-1, WebLogic
SNMP, DB2, SAPGUI, PeopleSoft (Tuxedo), MS COM+, and Tuxedo.

When you stop a named VTS instance, the instance may continue to run until you restart the VTS Windows
service, which will block you from creating an instance with the same name or port. 
Workaround: Restart the Windows service. For example, use the “net stop vtsservice” to stop the service, and
“net start vtsservice” to restart it.

Non-English Operating Systems

For non-English operating systems: Several components may contain untranslated items, such as the Print
Preview page in VuGen, log files, and installation screens.

LoadRunner cannot record a Vuser script for certain protocols if the LoadRunner installation is on a Chinese
operating system, and the installation path contains Chinese characters.

If you need to use non-English symbols in paths to scripts, scenarios, results, or analysis sessions, make sure to
select the appropriate locale in the your machine's Region and Language settings. Path names cannot be in
multi-byte format. Script names, however, must be in English.

 Integrations

This section provides integration information about:

Data Format Extensions (DFE) Support

HP Performance Center

HP Service Virtualization

 Data Format Extensions (DFE) Support

The following DFEs are supported on both Windows and Linux: Base64, JSON to XML, PrefixPostfix,
UrlEncoding, and XML.

The following DFEs are supported only on Windows machines: XSS, GWT, and Remedy.



 HP Performance Center

You cannot connect from VuGen to an SSL enabled Performance Center host when the Performance Center
server is using SSO for authentication.

 HP Service Virtualization

When running a scenario with an HP Service Virtualization project, if you change the Service Virtualization
settings on the Design tab, they are not applied to the HP Service Virtualization servers.

A Service Virtualization project cannot be correctly imported to a scenario, if the HP Service Virtualization server
uses credentials for both SSL and monitors.
Workaround: Configure the HP Service Virtualization server to use credentials only for SSL.

 Protocol SDK

When building MSIs, non-English characters in file and path names are not supported.

To run the Protocol SDK, you must have Administrator permissions, and the Run all administrators in
Admin Approval Mode setting must be disabled.

The Protocol SDK supports 32-bit and 64-bit MSIs for LoadRunner, VuGen, and PC-Host; For PC-Server, only
32-bit MSIs are supported.

For LoadRunner, VuGen, and PC-Host, PatchAddin support is for TARGETDIR files only.

Additional Resources
HP Software Support Online

HP Live Network (HPLN)

LoadRunner Blog

LoadRunner Community Forums

LoadRunner Knowledge Base

LoadRunner Integrations

Support Information
Visit the HP Software Support Online web site at: http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support that HP Software
offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access
interactive technical support tools needed to manage your business. As a valued support customer, you can benefit
by using the support web site to:

Search for knowledge documents of interest
Submit and track support cases and enhancement requests
Download software patches
Manage support contracts
Look up HP support contacts
Review information about available services
Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract. To register for an HP Passport ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to:

http://www.hp.com/go/hpsoftwaresupport
https://hpln.hp.com/group/performance-center-and-loadrunner
http://h30499.www3.hp.com/t5/HP-LoadRunner-and-Performance/bg-p/sws-585
http://www.hp.com/go/lrpc
http://h20230.www2.hp.com/troubleshooting.jsp
http://support.openview.hp.com/sc/solutions/index.jsp#tab=tab3


      http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables
you to explore HP Product Solutions to meet your business needs, includes a full list of Integrations between HP
Products, as well as a listing of ITIL Processes. The URL for this Web site is
http://h20230.www2.hp.com/sc/solutions/index.jsp

Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying
such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall
not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with
FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data
for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.
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